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Records Management System
Records Management System allows your agency to track, print, search and summarize many of
the daily reports and activities. This RMS package includes: Incident Reports, Arrest Reports, Mug
Shots, Log Citations, Case Management, Warrant Tracking, Evidence Tracking, and Accident Reports.
With all of that in one program it has become NIBRS approved for automated state reporting in North
Carolina, Virginia, South Carolina, Tennessee, Alabama, Georgia, Florida, Texas and Arkansas.
All of the aspects of the program can be accessed from your squad car, for agencies that are
running live. While you are on scene you can enter your report, search for active warrants, search for
active criminal trespasses, it is all there at the tip of your fingers ready to be used, if your agency runs
live.

This manual will help guide you through the RMS for Law Enforcement program. Keep in mind that
there can be a time where your local policy and procedure will instruct you to do something different,
and we suggest not going against local policy and procedure. There are features mentioned
throughout this manual that are state regulated and cannot be changed though.
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Incident / Investigations

Most actions can be done two ways through the drop downs from the toolbar or by clicking on the
icon. Hold the mouse over an icon it will have a pop up that tells you what the icon means.
New Incident Report
Open in supplement/edit mode
Open in view mode only
Save
Route Report
Print
Print Preview
Print Redaction Report
Cut
Copy
Paste
Spell Check
Find
Find & Replace
Validate
Exit to Previous Screen
Help
It is best to go blank by blank to complete a report; this will help to have fewer errors when validating
the report.
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Offense Tab

Make sure you have each offense listed. Start with the highest/most serious charge. The crime
categories are listed below in alphabetical order for ease of reference rather than in the order of their
importance. Additionally, each offense’s NIBRS code precedes its name.
Remember that offenses should be classified according to IBRS definitions and not according to state,
local, or Federal codes.
Offense Code: This is the code that you match the statute to using the NIBRS Code Book for assistance.
The RMS system is set up to assist by only allowing you to choose the association of a NIBRS code that
applies to a penal code.
Note: Only list actual crimes committed, not the number of times the offender was charged with the
offense or elements of the crime.
HOMICIDE: The willful (non-negligent) killing of one human being by another.
0110 Murder and Non-negligent Manslaughter - As a general rule, any death due to injuries
received in a fight, argument, quarrel, assault, or commission of a crime.
0120 Manslaughter by Negligence - The killing of another person through gross negligence.
This offense does not include “Vehicular Manslaughter” which is reportable as “All Other
Offenses” (2690).
Note: “Assault to Murder” and “Attempted Murder” are to be reported as Aggravated
Assault. All homicides must have a circumstance code, located on the General Tab.
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SEX OFFENSES, FORCIBLE: Any sexual act directed against another person, forcibly and/or against that
person’s will; or, not forcibly or against the person’s will where the victim is incapable of giving
consent.
0200 Forcible Rape - The carnal knowledge of a female, forcibly and/or against that person’s
will; or, not forcibly or against the person’s will where the victim is incapable of giving consent
because of her temporary or permanent mental or physical incapacity. There must be vaginal
penetration if an offense is scored as Forcible Rape (0200).
Note: All Forcible Rapes (0200) must have a Rape Place of Encounter Code and a Rape
Marital Status Code, located on the General Tab.
(See codes 1710-1790 for Other Sex Offenses)
ROBBERY: The taking, or attempting to take, anything of value under confrontational circumstances
from the control, custody, or care of another person, or persons, by force or threat of force or violence
and/or by putting the victim in fear of immediate harm.
0300 Robbery
Note: Because some type of assault is an element of the crime of Robbery, an assault
should not be reported as a separate crime as long as it was performed in furtherance of
the robbery. However, if the injury results in death, a Homicide Offense must also be
reported. Robbery is considered a crime against property and is scored one per act or
operation. All robberies must have offender tab completed and all robberies against
individuals must have victim tab completed.
AGGRAVATED ASSAULT: An unlawful attack by one person upon another wherein the offender uses a
weapon or displays it in a threatening manner or the victim suffers obvious severe or aggravated bodily
injury involving apparent broken bones, loss of teeth, possible internal injury, severe laceration, or loss
of consciousness.
0410 Aggravated Assault
0420 Aggravated Assault With Sexual Motives
Note: All aggravated assaults must have a circumstance code, located on the General
Tab.
Note: If circumstance “Other Felony Involved” (08) is used, the other felony (crime)
involved must be reported as a second offense. All officer assaults must also have an
officer activity and officer assignment code.
Note: All assaults must have victim and offender tabs completed. An assault is generally
considered aggravated when a weapon is used, displayed or use is threatened. Any
assault with hands, fists, or feet inflicting serious injury on the victim and/or requiring
medical attention would be an aggravated assault. Assaults are considered crimes
against persons and are scored one per victim.
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BURGLARY: Unlawful entry into a building or other structure with intent to commit a felony or theft.
0510 Burglary - Forcible Entry - Entry of a structure obtained through the breaking or forcing
open of windows, doors, screens or roofs also, includes the use of tools, picks, unauthorized
keys or other devices that may leave no outward marks but are used to force or bypass a lock.
0520 Burglary - Non-Forced Entry - Entry of a structure is obtained through use of unlocked
doors or windows.
Note: Burglary is considered a crime against property and is scored one offense per
each act or operation. In order for a burglary to occur there must be a structure
involved and the element of trespass must exist. Motor vehicles are not considered
structures. Multiple burglaries of motel / hotel rooms and storage units that are under a
single manager and that occur at the same time are generally scored as one incident,
and, therefore, should be scored as one act or operation. Multiple burglaries of
dormitory rooms or other living areas that are rented for a period of time should be
scored as separate distinct operations.
LARCENY - THEFT: The unlawful taking, carrying, leading, or riding away of property from the
possession, or constructive possession, of another person.
0610 Pocket-picking - Theft of articles from another person’s physical possession by stealth;
where the victim usually does not become immediately aware of the theft.
0620 Purse-snatching - The grabbing or snatching of a purse, handbag, etc., from the physical
possession of another person.
Note: If more force was used than actually necessary to wrench the purse from the
grasp of the person, then a strong-arm Robbery occurred, rather than Purse-snatching.
0630 Shoplifting - The theft, by someone other than an employee of the victim, of goods or
merchandise exposed for sale.
0640 Theft From Motor Vehicle (Except of Motor Vehicle Parts or Accessories) - The theft of
articles from a motor vehicle, whether locked or unlocked.
Note: This category also includes items taken from the trunk and the bed of a truck.
0650 Theft of Auto Parts or Accessories - The theft of any part or accessory affixed to the
interior or exterior of a motor vehicle in a manner which would make the item an attachment
of the vehicle, or necessary for its operation.
Note: Ex. include license plates, CD players, batteries, gas, tires, and wheel covers.
0660 Theft From Building - A theft from within a building which is either open to the general
public or where the offender has legal access.
Note: The items taken usually are not for sale. Ex. include items taken from a person at
work where neither pocket-picking nor purse-snatching are involved, authorized visitors
in a home where items are taken, and thefts from public buildings.
0670 Theft From Coin-Operated Machine or Device - A theft from a machine or device which is
operated or activated by the use of coins.
0690 All Other Larceny - All thefts which do not fit any of the definitions of the specific
subcategories of Larceny/Theft listed above.
Note: Ex. Thefts from fenced enclosures, boats, and airplanes, of animals, lawnmowers,
hand tools, farm/construction equipment, trailers/campers, items taken from porches,
carports, construction trailer that is not a permanent fixture, a house/business under
construction with no indication of burglary, gas drive offs.
Note: Larceny theft is considered a property crime and is scored one per distinct
operation.
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MOTOR VEHICLE THEFT: The taking or attempting to take a motor vehicle. A motor vehicle is a selfpropelled vehicle that runs on the surface of land and not on rails.
0710 Automobiles - Sedans, coupes, station wagons, convertibles, taxicabs or other similar
motor vehicles which serve the primary purpose of transporting people.
0720 Trucks - Specifically designed (but not necessarily used) to transport commercial cargo.
0730 Buses - Specifically designed (but not necessarily used) to transport groups on a
commercial basis.
0740 Recreational Vehicles - Specifically designed (but not necessarily used) to transport
people and also provide them temporary lodging for recreational purposes.
0790 All Other Vehicles - Any other motor vehicles: motorcycles, motor scooters, snowmobiles,
golf carts, etc.
Note: Do not include farm equipment, bulldozers, airplanes, construction equipment or
motorboats. These types of theft should be scored as “All Other Larceny” (0690). Failure
to return rental cars would be scored as Fraud. Do not score vehicles that were
recovered in your jurisdiction but were stolen in another jurisdiction. A recovery of a
stolen vehicle from another jurisdiction, where there was no arrest for possession of
stolen property, must be scored as a Call for Service (9910). Motor Vehicle Theft is
considered a crime against property and is scored one per distinct operation.
SIMPLE ASSAULT: An unlawful attack by one person upon another where neither the offender displays
a weapon, nor the victim suffers obvious severe or aggravated bodily injury involving apparent broken
bones, loss of teeth, possible internal injury, sever laceration, or loss of consciousness.
0810 Physical Assault (Non-aggravated)
0820 Non-physical Threat, Intimidation - To unlawfully place another person in reasonable fear
of bodily harm through the use of threatening words and/or other conduct, but without
displaying a weapon or subjecting the victim to actual physical attack.
0830 Physical Assault with Sexual Motive (Non-aggravated)
0840 Non-physical Threat, Intimidation with Sexual Motive
0890 All Other Simple Assault
Note: All simple assaults must have a circumstance code, located on the General Tab.
Note: If circumstance “Other Felony Involved” (08) is used, the other felony (crime)
involved must be reported as a second offense. All officer assaults must have an officer
activity and officer assignment code.
Note: An assault is generally considered a simple assault when no weapon is used;
neither displayed nor is its use threatened. Usually the victim requires no medical
attention. Stalking would be scored as “Non-physical Threat” (0820). Harassing phone
calls in which a threat is made on an individual would be scored as “Non-Physical
Threat” (0820). Other types of prank calls would be scored as “All Other Offenses”
(2690).
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ARSON: To unlawfully and intentionally damage, or attempt to damage, any real or personal property
by fire or incendiary device.
0900 Arson
Note: - Ex. of property includes a dwelling house, public building, motor vehicle, aircraft,
and the personal property of another. Do not count dumpster fires. Heat and water
damage to adjacent property is counted in arson property damage. Citizens killed as a
result of arson would be scored as murder; however, firefighters killed in the course of
fighting arson would not be counted as murder. Arson is considered a crime against
property and is counted one per distinct operation. Type of property burned must be
indicated in property section.
FORGERY: The altering, copying or imitation of something, without authority or right, with the intent
to deceive or defraud by passing the copy or thing altered or imitated as that which is original or
genuine; or the selling, buying, or possession of an altered, copied, or imitated thing with the intent to
deceive or defraud.
1011 Forgery - Buying/Receiving
1012 Forgery - Selling/Distributing
1013 Forgery - Possessing/Concealing
1014 Forgery - Transporting
1015 Forgery - Using/Uttering
1016 Undetermined
Note: Ex. of forgery would be wills, deeds, public records, bonds, altered money,
prescriptions and checks. Forgery is considered a crime against property and is counted
one per distinct operation.
COUNTERFEITING: The actually making of bills, coins, plates, banknotes, checks, trademarks, drafts,
cards, etc.
1021 Counterfeiting - Buying/Receiving
1022 Counterfeiting - Manufacturing
1023 Counterfeiting - Selling/Distributing
1024 Counterfeiting - Possessing/Concealing
1025 Counterfeiting - Transporting
1026 Counterfeiting - Using
1027 Counterfeiting - Undetermined
Note: Counterfeiting is considered a crime against property and is counted one per
distinct operation.
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FRAUD: The fraudulent conversion and obtaining money or property by false pretenses. This includes
bad checks, confidence games, etc.
1110 Worthless Checks
1120 Obtaining Money/Property by False Pretense
1130 Confidence Games/Larceny by Trickery
1140 Unauthorized Use of Conveyance
1150 Credit Card Fraud/Automated Teller Machine
1160 Welfare Fraud
1170 Impersonation
1180 Wire/computer Fraud/Other Electronic Manipulation
1190 All Other Fraud
Note: Fraud does not include forgeries or counterfeiting. Examples of fraud are
changing price tags, pumping more gas than contracted for, failure to pay at a
restaurant, failure to return rental property, not honoring a contract, etc. Fraud is
considered a crime against property and is counted one per distinct operation.
EMBEZZLEMENT: The unlawful misappropriation by an offender to his/her own use or purpose of
money, property, or some other thing of value entrusted to his/her care, custody, or control.
1210 Embezzlement Via Paper
1220 Wire/computer/Other Electronic Manipulation
1290 All Other Embezzlement
Note: Embezzlement is usually larceny from an employer. Embezzlement is considered a
crime against property and is counted one per distinct operation.
STOLEN PROPERTY: The receiving, buying, selling, possessing, concealing, or transporting any property
with the knowledge that it has been unlawfully taken as by Burglary, Embezzlement, Fraud, Larceny,
Robbery, etc.
1310 Buying/Receiving Stolen Property
1320 Selling/Distributing Stolen Property
1330 Possessing/Concealing Stolen Property
1340 Transporting Stolen Property
Note: Stolen property is considered a crime against property and is counted one per
distinct operation.
VANDALISM: To willfully or maliciously destroy, damage, deface, or otherwise injure real or personal
property without the consent of the owner or the person having custody or control of it.
1400 Vandalism/Damage to Property
Note: Do not score accidental property damage or damage caused by nature (wind, hail,
etc.) as Vandalism/Damage to Property. A shooting into an occupied building with no
chance of injury would be scored as vandalism. Vandalism is considered a crime against
property and is counted one per distinct operation.
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WEAPON LAW VIOLATIONS: The violation of laws or ordinances prohibiting the manufacture, sale,
purchase, possession, transportation, concealment, or use of firearms, cutting instruments, explosives,
incendiary devices or other deadly weapons.
1510 Buying/Receiving Weapons
1520 Selling/Distributing Weapons
1530 Possessing/Concealing Weapons
1540 Transporting Weapons
1550 Using (Illegal Discharge) Weapons
1590 Other Weapon Violations
Note: Weapon law violations are considered a crime against society and are counted
one per distinct operation.
PROSTITUTION OFFENSES: To unlawfully engage in or promote sexual activities for profit.
1610 Prostitution - To unlawfully engage in or promote sexual activities for profit.
1620 Assisting/Promoting Prostitution - To solicit customers or transport persons for
prostitution purposes; to own, manage, or operate a dwelling or establishment for the purpose
of providing a place where prostitution is performed; or to assist or promote prostitution.
Note: Prostitution offenses involve both male and female offenders. Prostitution
offenses are considered a crime against society and are counted one per distinct
operation.
SEX OFFENSES:
1710 Peeping Tom - The act of watching a person without their knowledge for sexual intent or
pleasure.
1720 Sodomy (Crime Against Nature) - Oral or anal sexual intercourse with another person,
forcibly and/or against that person’s will; or not forcibly or against the person’s will where the
victim is incapable of giving consent because of his/her youth or because of his/her temporary
or permanent mental or physical incapacity.
1730 Indecent Exposure - The act of exposing oneself for sexual intent or pleasure.
1740 Incest – Non-forcible sexual intercourse between persons who are related to each other
within the degrees wherein marriage is prohibited by law.
1750 Male Rape - Same as Forcible Rape, female (0200).
1760 Sexual Assault with an Object - To use an object or instrument to unlawfully penetrate,
however slightly, the genital or anal opening of the body of another person, forcibly or against
that person’s will; or, not forcibly or against the person’s will where the victim is incapable of
giving consent because of his/her youth or because of his/her temporary or permanent mental
or physical incapacity.
1770 Statutory Rape – Non-forcible sexual intercourse with a female who is under the statutory
age of consent.
1780 Molestation - The touching of the private body parts of another person for the purpose of
sexual gratification, forcibly and/or against that person’s will; or, not forcibly or against the
person’s will where the victim is incapable of giving consent because of his/her youth or
because of his/her temporary or permanent mental or physical incapacity.
Note: Examples include taking indecent liberties and child molesting.
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1790 All Other - Any sexual offense not listed above except for prostitution.
Note: An overt act other than simply fondling with nothing spoken (unzipping pants,
straddling) would be considered attempted rape. Fondling with nothing spoken is not
attempted rape. Fondling with the mention of rape is attempted rape. Sex offenses are
considered crimes against persons and are scored one per victim.
DRUG/NARCOTIC OFFENSES: The violation of laws prohibiting the production, distribution, and/or use
of certain controlled substances and the equipment or devices utilized in their preparation and/or use.
1810 Drug/Narcotic Violations - The unlawful cultivation, manufacture, distribution, sale,
purchase, use, possession, transportation, or importation of any controlled drug or narcotic.
1820 False Representation of Drugs
DRUG EQUIPMENT VIOLATIONS: The unlawful manufacture, sale, purchase, possession, or
transportation of equipment or devices utilized in preparing and/or using drugs or narcotics.
1831 Equipment / Paraphernalia Buying
1832 Equipment / Paraphernalia Manufacturing
1833 Equipment / Paraphernalia Selling
1834 Equipment / Paraphernalia Possessing / Concealing
1835 Equipment / Paraphernalia Transporting
1836 Equipment / Paraphernalia Using
1890 All Other Drug Violations
Note: Do not count “Driving Under the Influence” under drug violations. All
drug/narcotic offenses are considered crimes against society and are scored one per
distinct operation.
GAMBLING OFFENSES: To unlawfully bet or wager money or something else of value; assist, promote,
or operate a game of chance for money or some other stake.
1920 Betting and Wagering
1930 Operating / Promoting / Assisting Gambling
GAMBLING EQUIPMENT: To unlawfully manufacture, sell, buy, possess, or transport equipment,
devices, and/or goods used for gambling purposes.
1941 Equipment Violations Buying
1942 Equipment Violations Manufacturing
1943 Equipment Violations Selling
1944 Equipment Violations Possessing / Concealing
1945 Equipment Violations Transporting
1946 Equipment Violations Using
SPORTS TAMPERING: To unlawfully alter, meddle in, or otherwise interfere with a sporting contest or
event for the purpose of gaining a gambling advantage.
1950 Sports Tampering
1990 All Other Gambling Offenses
Note: All gambling offenses are considered crimes against society and are scored one
per distinct operation.
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OFFENSES AGAINST FAMILY (nonviolent): Unlawfully, nonviolent acts by a family member (or legal
guardian) which threaten the physical, mental or economic well-being or morals of another family
member, and which are not classifiable as other offenses, such as Assault, Incest, Statutory Rape, etc.
2010 Desertion / Abandonment
2020 Non-support / Nonpayment of Alimony
2030 Child Neglect (Non-assaultive) Example: No supervision.
2040 Child Abuse (Non-assaultive) Example: Overworking a child.
2090 All Other Example: Violating custody decrees.
Note: Offenses against family are considered crimes against persons and are scored one
per victim.
DRIVING WHILE IMPAIRED: The driving or operating of a motor vehicle while mentally or physically
impaired, as the result of consuming an alcoholic beverage or using a drug or narcotic.
2100 Driving While Impaired
Note: DWI is considered a crime against society and is scored one per distinct operation.
LIQUOR LAW VIOLATIONS: The violations of laws or ordinances prohibiting the manufacture, sale,
purchase, transportation, possession, or use of alcoholic beverages.
2210 Buying / Receiving Tax Paid Liquor
2211 Selling / Distributing Tax Paid Liquor
2212 Possessing / Concealing Tax Paid Liquor
2213 Transporting Tax Paid Liquor
2214 Using / Consuming Tax Paid Liquor
2220 Buying / Receiving Non-tax Paid Liquor
2221 Selling / Distributing Non-tax Paid Liquor
2222 Possessing / Concealing Non-tax Paid Liquor
2223 Transporting Non-tax Paid Liquor
2224 Using / Consuming Non-tax Paid Liquor
2225 Manufacturing Non-tax Paid Liquor
2230 Illegal Sale to Minors
2240 Sale Outside Prescribed Hours
2250 Sale Without License
2290 All Other Liquor Law Violations
Note: Liquor law violations are considered crime against society and are scored one per
distinct operation.
DISORDERLY CONDUCT: Any behavior that tends to disturb the public peace or decorum, scandalize
the community, or shock the public sense of morality.
2410 Disorderly Conduct
2420 Disturbing the Peace
2430 Fighting (Affray)
2440 Unlawful Assembly
2450 Drunk and Disruptive
2490 All Other
Note: Disorderly conduct also includes profanity and public nuisance. Disorderly
conduct is considered a crime against society and is scored one per distinct operation.
Page | 15

OBSCENE MATERIAL / PORNOGRAPHY: The violation of laws or ordinances prohibiting the
manufacture, sale, publishing, purchase, or possession of sexually explicit material, e.g., literature,
photographs, etc.
2510 Buying / Receiving
2520 Selling / Distributing
2530 Possessing / Concealing
2540 Transporting
2550 Using
2560 Publishing
2570 Exploiting Children
2580 Operating/promoting
2590 All Other
Note: Obscene material/pornography violations are considered crimes against society
and are counted one per distinct operation.
ALL OTHER OFFENSES: All crimes that are not specifically named in one of the above categories.
2610 Bigamy-marriage Laws
2620 Kidnapping
2630 Blackmail /Extortion
2631 Bribery
2640 Contempt of Court, Perjury, Court Violations
2650 Escape from Custody or Resist Arrest
2660 Parole and Probation Violations
2670 Trespassing
2680 City Ordinance Violations
2690 All Other
ADDITIONAL OFFENSE CATEGORIES: These categories are not necessarily criminal in nature.
4010 All Traffic (Except DWI)
4020 Suicide (The deceased is the victim. There would be no Case Status or Disposition).
4030 Non-negligent Traffic Death
4040 Non-Criminal Detainment (Involuntary Commitment)
8010 Missing Person (Victim information is mandatory.)
8011 Runaway
9910 Calls for Service
Statute: Enter the state code of the offense being reported.
Offense Description: This can fill when you select the Offense Code or the State Code, depending how
your agency sets it up. If you leave as is, it is easier for the agency to better create searches.
Attempted/Complete: Choose if the offense is attempted or completed.
Offense Type/Degree: Choose which ones best fit the charge.
Counts: How many counts of the exact same charge in total. (Combine all offenders)
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General Tab

Even though the Southern Software CAD (if your agency uses this program) pulls some information
over from when the call is entered by a dispatcher, you have to check over the information to make
sure that it is correct.
Throughout RMS there are some time savers that will help with your entries.
TIME SAVER: F5 will insert the current date & F6 will insert current time.
Report Date/Time: This is time stamped and imported from CAD, from when the call came in (if you
have CAD), or enter the date and time that the report was taken. The time field is set to Military time.
At Found Date/Time: Insert the date and time the incident is found to have happened by the
complainant.
Last Known Secure Date/Time: Insert the latest date and time known to be prior to the crime.
Location Of Incident: Make sure it’s the correct location of the offense. (These import from CAD, but
dispatchers are not always given the correct location) You will have to add city, state and zip.
TIME SAVER: When you start to type a city it can auto fill the state and zip.
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Offense Tract: This is optional and can be mandated by your agency to use this or not for the area
(zone, beat, grid, etc.) within the agency’s jurisdiction of where the incident occurred.
Premise Type: Choose which best applies.
Residential Buildings:
01 Home of Victim - Single Family Dwelling
02 Home of Victim - Other Dwelling
03 Home of Offender - Single Family Dwelling
04 Home of Offender - Other Dwelling
08 Other Residence - Single Family Dwelling
09 Other Residence - Other Dwelling
Retail Establishments:
10 Convenience Store
11 Grocery/Supermarket
12 Jewelry Store
13 Liquor Store
14 Pharmacy
15 Restaurant
16 Service/Gas Station
29 Other Retail Establishment
Non-Residential Buildings:
30 Air/Bus/Train Terminal
31 Bar/Nightclub/Lounge
32 Church/Synagogue/Temple
33 Commercial/Office Building
34 Financial Institution
35 Government/Public Building
36 Hotel/Motel
37 Jail/Prison
38 School/College
39 Medical Facility
49 Other Non-residential Buildings
Parking Areas:
50 Enclosed Parking Deck
51 Parking Lot/Area
Storage Facilities:
55 Rental/Commercial Storage Facility
56 Residential Outbuilding/Storage
Open Areas:
60 Behind Building/Alley
61 Construction Site
62 Highway/Road/Street, etc.
63 Lake/Waterway/Ocean
64 Open Land Areas
Other Premises:
98 All Other
99 Unknown

How Attacked or Committed: Describe in a brief summary how the attack or crime was committed.
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Reporting Officer: The primary officer that was dispatched. This may have changed by the officers’
discretion on the scene of the incident; you will need to make sure that it is correct.
Notified/Arrived/Cleared Scene/Dispatcher: This is information regarding your response.
Case Status: Choose which best fits the current working status, this is a mandatory field.
1 Further Investigation
2 Inactive
3 Closed / Cleared (case disposition required)
4 Closed / Leads Exhausted
Case Disposition: Choose which best fits, if the case has been disposed of at the time the report has
been submitted you must indicate the disposition.
1 Unfounded (reported crime did not occur)- If a complaint is found to be false or baseless after
investigation, then this category should be selected. Do not classify a case as unfounded if
there are no leads available, stolen property was recovered, victim refuses to prosecute or
the incident seems insignificant.
2 Cleared by Arrest / Juvenile No Custody
3 Cleared by Arrest by Another Agency
4 By Death of the Offender
5 Victim Refused to Cooperate- Lack of prosecution on the part of the victim
6 Prosecution Declined
7 Extradition Declined
9 Cleared by Locating (missing person or runaway only)
Date Closed/Cleared: Enter a date.
Closed/Cleared By: This will be the officer/investigator that clears the case/report.
The clearance of an incident does not always mean closing the investigation.
Suspect Hate/ Bias Motivated& Type: The options in the drop down should be reported ONLY if
investigation reveals sufficient objective facts that lead to a reasonable and prudent person to
conclude that the offender’s actions were motivated in whole or in part by bias against race, religion,
disability, ethnicity, or sexual orientation.
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Assault/Homicide Circumstances: All homicides must have a circumstance code.
01 - Argument
02 - Assault on Law Enforcement Officer
03 - Drug Dealers
04 - Gangland
06 - Lovers Quarrel
07 - Mercy Killing
08 - Other Felony Involved
09 - Other Circumstance
10 - Unknown Circumstance
11 - Child/Parental Abuse
12 - Spouse Abuse
13 – Institutional
20- Criminal Killed by Private Citizen
21-Criminal Killed by Police Officer
30- Child Playing with Gun
31-Gun Cleaning Accident
32- Hunting Accident
33- Other Negligent Handling
34-Other Negligent Killings

Justifiable Homicide Sub-Circumstance: All justifiable homicides must have a sub-circumstance code.
A - Criminal Attacked Police Officer and That Officer Killed Criminal
B - Criminal Attacked Police Officer and Criminal Killed by another Police Officer
C - Criminal Attacked a Civilian
D - Criminal Attempted Flight from a Crime.
E - Criminal Killed in Commission of a Crime.
F - Criminal Resisted Arrest
G - Unable to Determine/Not Enough Information

Rape Place of Encounter: All forcible rapes must have this code entered, choose which best applies to
the location of where the incident occurred.
Incident Type: This is imported from CAD as to how the call was given to them for a call type, or your
agency can create what needs to be populated in this field.
Reportable Box: Please uncheck this box if you are doing the report for “information” purposes
only. To make an un-reportable offense report easy.
Dispatch Zone/Section, Patrol Zone/Grid, Other Zone/Beat: These are used if you jurisdiction is divided
into beats, sectors, etc.
Weapons/Tools Used: Choose up to 3 codes for the weapon/tool that the offender used on the
primary offense.
Additional Responding/Assisting Officers: Make sure that you include ALL officers that were on scene at
the incident that assisted you.
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MO Characteristics: This is for internal departmental information. This is free text box, or a drop list
can be created by an administrator. This is a searchable field.

Victim Tab

TIME SAVER
When you begin to enter a name, it can pull matches from the Master Name Index if the
person has been handled before. In that index it stores all information we have on that person (address, date of
birth, etc.). You may select the person and add any information to them that you have now that was not entered
before or make any changes that are necessary. IF you do make changes or additions, press F10 to update the
Master Name File. You must make sure it is the same person before you select them. Once you select them it
will Auto-Fill all information the index has.
You must enter ALL victims involved.
Victim Type: Only one code per victim.
I Person/Individual
B Business
F Financial Institute
G Government
L Law Enforcement Officer in the Line of Duty
R Religious Organization
S Society/Public
U Other/Unknown
Note: If the type is I-Person/Individual or L Law Enforcement Officer in the Line of Duty (L should only be
used when the Officer is assaulted or killed in the line of duty); you must also complete Injury,
Drug/Alcohol Use, Age, Race, Sex, Relationship and Residence Status. Victims that are listed as State of
North Carolina would be scored as “S” for Society. An example of the victim type of Government would
be the thief of state, county, or city property.
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Injury Type: The type of bodily injury suffered by the primary victim during the incident. This is the law
enforcement officer’s initial assessment of the most serious injury suffered by the primary victim.
N None
M Apparent Minor Injuries
T Loss of Teeth
B Apparent Broken Bones
L Severe Lacerations
I Possible Internal Injuries
U Unconsciousness
O Other Major Injuries
Drug/Alcohol Use: Choose if any or all of the victims were suspected to be under the influence of alcohol or
drugs at the time the offense occurred.
Name, SSN, Address, Phone Numbers, Occupation, Employer, etc. all of these fields need to be completed to the
best of your knowledge. When entering the phone number for the offender you can click the double arrow
button to the right of the field to enter a second number, a blue plus sign will appear above the field to show
that a second number has been entered. When you print the report both numbers will print.
Date of Birth/Age: You must enter it one of the following ways; Exact, 00=Unknown, 99=Over 98 years of age,
BB=7 to 364 days of age, NB=1 to 6 days of age, NN=Under 24 hours of age.
Race/Sex: Must enter one.
Relationship To Offender: Relationship is an important data element that allows for analysis of crime in areas
such as domestic violence. Therefore, the proper relationship between victim and offender should always be
determined and reported.
Victim Resident Type: Must enter one. Non-Resident-Lives out of your jurisdiction..
Resident-A person who maintains his/her permanent home for legal
purposes in your jurisdiction.
Unknown- Cannot obtain a residential address.
LE Officer/Assignment/Activity: This needs to be completed if the report involves an officer, and then choose
which options apply.
Vehicle Information: Enter all known information in regards to the victims vehicle, if the vehicle also needs to be
reported as property (ex. Burglarized, damaged, etc.) you can also check the Report As Property? Box and the
needed information will copy to the property tab.
Crime(s) Related to Victim: Indicate up to three crimes committed against one victim. In situations where an
incident consists of multiple offenses and multiple victims, it is extremely important to link the proper crimes
with the proper victims. For example, in a murder/suicide incident, there would be two offenses and two
victims. However, the murder victim must be linked only to the murder and the offender must be linked only to
the suicide. Linking both offenses to both victims would result in the scoring of two murders, when, in fact, only
one murder occurred.
Complete the rest of the blanks to the best of your knowledge.
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Others Involved Tab

TIME SAVER When you begin to enter a name, it can pull matches from the Master Name Index if
the person has been handled before. In that index it stores all information we have on that person
(address, date of birth, etc.). You may select the person and add any information to them that you
have now that was not entered before or make any changes that are necessary. IF you do make
changes or additions, press F10 to update the Master Name File. You must make sure it is the
same person before you select them. Once you select them it will Auto-Fill all information the index
has.
This section is for including everyone you dealt with that does not fall under Victim, Offender, or
Arrestee. Ex. Owner, Reporting Person, etc.
Complete the rest of the blanks to the best of your knowledge.
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Property Tab

Victim number: Choose which victim the property is associated with.
Item Type: Choose which best fits the type of property.
Animals:
01 Livestock
02 Pets/Other Animals
Consumable Materials:
11 Alcoholic Beverage
12 Consumable Foodstuffs
13 Household Goods
14 Drugs/Narcotics (stolen legal drugs or drugs obtained by Fraud/Forgery)
15 Drugs/Narcotics Equipment (drug paraphernalia)
16 Tobacco Products
17 Building Materials
18 Petroleum Products
19 Firearms/Ammunition
Crops and Landscaping:
21 Crops, Timber, etc.
22 Landscaping (shrubs, fences, etc.)
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Electronic Equipment and Accessories:
31 Camera/Optical Equipment (camcorder, binoculars, etc.)
32 Computer Hardware/Software
33 Office-Type Equipment
34 Radio/TV/VCR/Stereo Equipment
35 Recordings - Audio and Video (pre-recorded and blank tapes)
36 Telephone/Telephone Equipment
Jewelry and Collectibles:
41 Arts, Antiques and Collectibles
42 Jewelry/Precious Metals
Miscellaneous:
51 Clothes/Furs
52 Gambling Equipment
53 Musical Instruments
54 Sports and Recreation Equipment
55 Tools - Power and Hand
Monies and Securities:
61 Money (cash)
62 Negotiable Instruments (money orders, travelers’ checks, etc. that have been endorsed)
63 Non-negotiable Instruments (stocks, bonds, food stamps, etc. that have not been endorsed)
64 Credit/Debit Cards
65 Purses/Handbags/Wallets
Structures:
71 Structures - Single Occupancy Dwelling
72 Structures - Other Dwelling
73 Structures - Commercial/Business
74 Structures - Industrial/Manufacturing
75 Structures - Public/Community
76 Structures - Storage
77 Structures - Other
Vehicles and Parts:
81 Aircraft
82 Automobile
83 Bicycles
84 Boats/Water Craft
85 Buses
86 Commercial Trucks (tractor trailers)
87 Farm and Garden Vehicles and Implements
88 Heavy Construction/Industrial Equipment
89 Recreational Vehicles/Campers/Camper Trailers/Motor Homes
90 Trucks (designed to transport cargo, pick-up trucks)
91 Vans
92 Vehicle Parts/Accessories (utility trailers, license plates, tires, batteries, etc.)
93 Other Motor Vehicles
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Other Property:
98 Pending Inventory of Property
99 Other

Status: Choose what best describes the status of the property loss.
B Burned
C Counterfeited/Forged
D Damaged/Destroyed/Vandalized
R Recovered
Z Seized
S Stolen
L Lost
F Found
Value: Enter the TOTAL estimated value for that particular property, not the price per each piece of
particular property. If burned include damage from fighting the fire in the amount of the total. Round
to the nearest whole dollar.
o Use fair market value for articles which are subject to depreciation because of wear and
tear, age, etc.
o Use victim’s evaluation of items such as jewelry, watches, etc., which decrease slightly in
value or not at all with use or age.
o Use replacement cost or actual cash cost to victim for new or almost new clothes, auto,
accessories, bicycles, etc.
o Non-negotiable instruments such as travelers’ checks, personal checks, money orders,
stocks and bonds, etc. should be described but no value. Negotiable instruments such
as bonds payable to bearer are valued as the current market price at the time of the
theft
o NOTE: The value of the property recovered should not be greater than value of property
stolen.
 Ex.: 5 CD’s were stolen from a vehicle at $10 apiece. Your value that you enter
would be $50 and then in quantity 5.
For Other Jurisdiction: Check this box if property is for another jurisdiction.
Evidence/Non Reportable: If you are placing the properties in evidence for court reasons only or to be
held with no charges, check this box.
Quantity: The amount of that particular property.
Description: Fills from the Item Type box. You may fill in more detail. This section is designed to record
information concerning property stolen or recovered during an incident or offense.
Make/Brand, Model, Serial #, Owner Applied #, and Primary Color needs to be completed to the best of
your knowledge. This is also the information that will be needed to enter the property into NCIC/TCIC
once that has happened you can enter your NIC Number.
Item Category: If applicable, choose the best that describes the property.
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NCIC: This is where you can enter the TCIC/NCIC number that was given to the item when it was
entered into TLETS/NLETS.
Damage/Loss Amount: Only enter if Damaged or Loss. This will auto calculate when the amount
recovered is entered.
Owner: Any subject entered in the report will be in the drop down, choose one.
Stolen/Lost Property – Recovered/Found/Seized Property
Complete these 2 sections to the best of your knowledge when the selected property has been
Recovered/Found/Seized. This section is how the state helps clear your items stolen.
In the value block, indicate the estimated market value of the item(s) at the time of recovery
Number of Vehicles Stolen / Recovered: Motor Vehicle Theft Offenses Only. Enter the number of motor
vehicles stolen and recovered for the incident. The stolen number cannot be greater than the
recovered number.
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Drug Tab

The Drug Section should only be used when drugs are seized, burned or found. If drugs are stolen,
recovered, or forged as a result of a Burglary or a Forgery, enter the drugs under the Property Section.
Type of Drug: Identify the types of drug/narcotics seized in a drug case.
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P
U

“Crack” Cocaine
Cocaine (all forms except “crack”)
Hashish
Heroin
Marijuana
Morphine
Opium
Other Narcotics: Codeine; Demerol; Hydrocodone or Percodan; Methadone; etc.
LSD
PCP
Other Hallucinogens: BMDA or “White Acid”; DMT; MDA; Peyote; Psilocybin; STP; etc.
Amphetamines/Methamphetamines
Other Stimulants: Adipex, Fastine, and Derivative of Phentermine; Benzedrine; Didrex;
Methylphenidate or Ritalin; Phenmetrazine or Preludin; Tenuate; etc.
Barbiturates
Other Depressants: Glutethimide or Doriden; Methaqualone or Quaalude; Pentazocine or etc.
Other Drugs: Antidepressants (Elavil, Triavil, Tofranil, etc.); Aromatic Hydrocarbons; Darvon;
Tranquilizers (Chlordiazepoxide or Librium, Diazepam or Valium, etc); etc.
Unknown Drug Type

Status: Choose B Burned, Z Seized, or F Found
Quantity: Quantity seized. Nine characters are available to enter the number of whole pounds, ounces,
grams, etc. and 3 more characters are available for decimal amounts, that must be entered.
Unit of Measure: Quantifying drugs/narcotics seized in a drug case. Choose the way that you
measured it.
Activity Check Boxes: Choose the activity occurring involving the drug/narcotic violation, you may
choose up to 3. Posses, Buy, Sale, Mfg, Importing or Operating.
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Offender/Suspect Tab

TIME SAVER When you begin to enter a name, it can pull matches from the Master Name Index if
the person has been handled before. In that index it stores all information we have on that person
(address, date of birth, etc.). You may select the person and add any information to them that you
have now that was not entered before or make any changes that are necessary. IF you do make
changes or additions, press F10 to update the Master Name File. You must make sure it is the
same person before you select them. Once you select them it will Auto-Fill all information the index
has.
TOP SECTION
Involvement: Indicate the involvement of the person entered with the incident.
Drug/Alcohol Use: Choose whether or not the offender(s) is suspected to have been under the
influence of drugs and/or alcohol at the time of the incident.
Computer Use: Choose whether the offender(s) is suspected to have used a computer to assist in the
incident.
Resident Status: Must enter one. Non-Resident-Lives out of your jurisdiction..
Resident-A person who maintains his/her permanent home for legal
purposes in your jurisdiction.
Unknown- Cannot obtain a residential address.
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All information regarding the Offender: name, address, phone number, etc. is located here. Please
complete all of the information that you can to the best of your knowledge and ability.
Sex/Race: Must enter one.
Date of Birth: If you do not have one, go to the drop down under age and choose: 00=Unknown or
99=Over 98 years of age.
Armed: Select “Yes” if the suspect/offender/missing person is armed, or if he or she may be armed.
Select “No” if you are positive the suspect/offender/missing person is not armed. Select
“Unknown/UNK” if it is not known whether the person is armed. If “Yes” is selected for “Armed,”
enter the type of suspected weapon here. (E.g. Pistol, rifle, knife, etc.)
Complete the rest of the blanks to the best of your knowledge.
Bottom Tabs
1. Alias/Nickname
Enter ANY alias information (name, date of birth, SSN, etc.) you have on the offenders.
2. Physical Features
Select Feature: Type of feature (accent, tattoo, scar, etc).
Location: On the body part (center, right, all over, etc)
Body Part: Where at on the body is the feature located.
Description: Brief description of the feature (Ex. Accent-German, Tattoo-Tribal, Tattoo-Old
English “name”)
3. Clothing
Enter ANY clothing descriptions that you have in regards to the Offender/Suspect.
4. Vehicle
Complete this with the best information you have, regarding the vehicle involved with the
Offender/Suspect, and if the vehicle also needs to be reported as property.
5. ID Numbers
Complete to the best of your knowledge.
6. View Mug shot/Photo will be blue if a photo is associated with the person.
7. Barring Notice - This is a quick feature if the Offender needs to be criminally trespassed from
a location associated with the report. (The barring notice is partially customizable by
administration)
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Witness Tab

TIME SAVER When you begin to enter a name, it can pull matches from the Master Name Index
if the person has been handled before. In that index it stores all information we have on that person
(address, date of birth, etc.). You may select the person and add any information to them that you
have now that was not entered before or make any changes that are necessary. IF you do make
changes or additions, press F10 to update the Master Name File. You must make sure it is the
same person before you select them. Once you select them it will Auto-Fill all information the index
has.
Complete this tab to the best of your ability.

Page | 31

Narrative Tab

The primary purpose of this section of the I/O report is to inform others about the event being
reported. Officers should strive to answer the following questions when writing a narrative:
Who was involved?
What happened?
When did it happen?
Where did it happen?
How did it happen?
Why did it happen?
This section should tell the story of the officer’s actions and all other involved persons’ actions as they
relate to the event being reported. Remember, when writing the narrative, you are telling the story to
someone who does not know any of the facts surrounding the event. The narrative should give the
reader a clear picture of the event as observed by the reporting officer. The narrative section is also
used to expand upon or continue any items on the rest of the report where additional space or
explanation is needed.
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Vehicle Tab

Involvement: Choose which person in the report that the vehicle information being entered is related
to.
Description: Free text box, any additional info; such as decals, bumper stickers, dents, missing wheel
covers, etc.
Report as Property: If the vehicle is also property in the case you may click this to import some of the
information over to the Property Tab. TIME SAVER
Vehicle Category/Type: Choose the best description from the drop down that best describes the detail
of the vehicle.
Year, Make, Model, Style, Color, License Plate Year, License Plate, License Plate State, and VIN:
Complete these to the best of your knowledge.
Owner Applied Number: Any additional number that was added to the frame by the owner (SSN,
driver’s license number, etc.).
Value: This is the value of the vehicle when it was stolen.
Owner: Choose from the drop down
NCIC: After a dispatcher has entered the stolen vehicle information into NCIC/TCIC you will have a
generated NIC number to enter.
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Vehicle Disposition
Disposition: Choose if it was Impounded or Released to Owner.
Left At Scene: Choose whether or not it was left Secure or Unsecured.
Date/Time Left: When it was left on the scene abandoned.
Released To: The drop down box will have all subjects entered into the report, choose one.
Place of Storage: The name of the wrecker service that towed the vehicle, if it is one other than a City
of Forney Wrecker Service, include the phone number.
Inventory on File: Choose whether you completed an inventory on the vehicle or not.

Page | 34

Image Tab

You may attach images that were taken in reference to the incident and view them here. Each line
item is a free text field and you will need to give a brief description of the photo. When adding images
through this tab, the RMS system will compress the photos to all be the same size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.

Page | 35

Supplement Tab

Each Officer involved in the incident will need to type their supplements here. You cannot change
what the primary officer has entered into the report or change another officer’s supplement. When
you do add a supplement, make sure you choose the select the Supplement Type; Corrections, Officer
Action, Review, etc. This is also where you will find follow-up notes from other officers, or CID. To view
all supplements without printing, you can select to print and click preview instead of the print button.
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Extra Features
Case Management
File > Case Management>
> Case Management : Will Open the Case
Management screen on top of report.
> Open in Case Management Mode: Will
open a new screen of Case Management.
> Case Notes: This will open the Case Notes
feature, where you can enter notes for
the case that are not a part of Supplements.
To add a note in Case Note, make sure you
click Add Notes.
> Solvability Questions: This opens a feature
primarily for CID to help show the
percentage of the solvability of a case.
Print Redaction Report
File>Print Redaction Report
This feature allows you to create controls to
automatically block parts of printed reports. Once
you create a set of controls and name the report it
will remain in the defined template list. If you go to
the Manual Tab this is where it allows you to create
the controls to the fields that you want redacted
from the report.

Statement/Interview
Edit> Statement/Interview
This feature will only activate if you are on a person
tab and have a person entered. This allows you to
type the interview notes or statement into their
words. This is printable.
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Audit Trail/Scanned Documents/File Attachment
View>Audit Trail
This allows you to see or print modifications that
have occurred to that record.
View>Scanned Documents
This is an additional feature that may not be active
for your agency. If so, you will need TWAIN, WIA or
Windows Wizard to use this feature. This allows you
to scan in documents and attach them to a report.
This does compress the file.
View> File Attachments
This is an additional feature that may not be active
for your agency. It allows you to attach audio, video,
images, or scans to the incident without compressing
the file. You will need to Add and Attach New File,
Add File, and locate them through the computer,
once you select the file that you would like to attach,
click OK, and they are now attached. To view them
select the file you would like to view and click Open
File.
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Arrest
An arrest report is required every time every time an officer makes a criminal arrest. Arrest reports
provide a complete arrest history record and are a source of information for locating persons at a later
date.

General Tab

Check Digit Number: The fingerprint card number on the SBI Fingerprint Card for the arrestee. The CKN
is a unique identifier that is used to trace the arrest from the time of arrest through the judicial system.
This is an optional field.
Arrest Tract/Dispatch Zone/Patrol Zone: This is used to indicate an area (zone, beat, grid, tract, etc.)
within the jurisdiction where the arrest has occurred. This is an optional field. The tracts are assigned
by the agency.
Residence Tract: This is used to indicate an area (zone, beat, grid, tract, etc.) within the jurisdiction
where the arrestee resides. This is an optional field. The tracts are assigned by the agency.
Weapon: Indicate what type of weapon, if any the arrestee was armed with at the time of
apprehension.
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Type of Arrest: Indicate the type of apprehension.
1 On-view Arrest (taken into custody without a warrant or previous incident report)
2 Order for Arrest (do not include the original charge)
3 Criminal Summons (not taken into custody)
4 Citation
5 Warrant for Arrest
Place of Arrest: The location the arrest was made. (If a pursuit occurred the incident location and the
arrest location will be 2 different addresses)
Assisting Officers: Make sure that you include ALL officers that were on scene at the incident that
assisted you.
Complainant/Victim: Enter general information regarding the complainant of the arrest.
Arresting Officer: Enter the officer that actually conducted the arrest.
Juvenile Disposition: Enter the disposition which best applies with the action taken.
Case Status: Choose which best fits the status of the arrest.
1. Further Investigation
2. Inactive
3. Closed/Cleared
Case Status: Choose which best fits the status of the arrest.
02. Cleared by Arrest / No Supplement Needed
08. Arrest / No Investigation
Reportable Box: Please uncheck this box if you are doing the report for “information” purposes
only. To make an un-reportable offense report easy.
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Arrestee Tab

Top Half
Name, SSN, Address, Phone Numbers, Occupation, Employer, etc. all of these fields need to be
completed to the best of your knowledge.
Sex/Race: Must enter one
Resident Status: Must enter one. Non-Resident-Lives out of agencies jurisdiction.
Resident-A person who maintains his/her permanent
home for legal purposes in the jurisdiction where the
crime took place.
Unknown- Cannot obtain a residential address.
Complete the rest of the blanks to the best of your knowledge.
Bottom Tabs
1. Alias/Nickname
Enter ANY alias information (name, date of birth, SSN, etc.) you have on the offenders.
2. Physical Features
Select Feature: Type of feature (accent, tattoo, scar, etc).
Location: On the body part (center, right, all over, etc)
Body Part: Where at on the body is the feature located.
Description: Brief description of the feature (Ex. Accent-German, Tattoo-Tribal, Tattoo-Old
English “name”)
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3. Nearest Relative
Enter the next of kin information here.
4. ID Numbers
Complete to the best of your knowledge.

Offense Tab

Offense Code: Choose the best fitting category for the offense from the offenses listed in the original
report.
Statute: Enter the state code of the offense being reported.
Offense Description: This can fill when you select the UCR Code or the State Code, depending how your
agency sets it up. If you leave as is, it is easier for the agency to better create searches.
Offense Type/Degree: Choose the ones that apply to the charge listed.
Counts: How many counts of the exact same charge in total.
Offense Jurisdiction: Type the name of the agency that is actually holding the charge if it is different
than the arresting agency.
Warrant Date: Date on an issued warrant.
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Vehicle Tab

Year, Make, Model, Style, Color, License Plate Year, License Plate, License Plate State, and VIN:
Complete these to the best of your knowledge.
Place of Storage: The name of the wrecker service that towed the vehicle, and include the impound
number.
Confined / Bond Information
Complete this information to the best of your knowledge, most of this information will need to be
completed after the arraignment has been completed.
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Drug Tab

Type of Drug: Identify the types of drug/narcotics seized in a drug case.
Status: Choose B Burned, Z Seized, or F Found
Quantity: Quantity seized. Nine characters are available to enter the number of whole pounds, ounces,
grams, etc. and 3 more characters are available for decimal amounts. You must enter the decimal
point.
Unit of Measure: Quantifying drugs/narcotics seized in a drug case. Choose the way that you
measured it.
Activity Check Boxes: Choose the activity occurring involving the drug/narcotic violation, you may
choose up to 3. Posses, Buy, Sale, Mfg, Importing or Operating.
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Narrative Tab

This section will allow you to free text information in regards to the arrest and inmate.

Page | 45

Image Tab

You may attach images that were taken in reference to the incident and view them here. Each line
item is a free text field and you will need to give a brief description of the photo. When adding images
through this tab, the RMS system will compress the photos to all be the same size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.
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Accident

This module is set up to be completed just like the North Carolina Accident Form, once completed it
will print in the North Carolina Accident Form format.

General Tab
Accident Number: This will depend on internal policy, they can be set to auto assign or it can be
manually completed to match another incident number possibly assigned by CAD.

Unit Tab
Make sure that you enter your units in the number order they belong you do not assign the units
numbers; it assigns them in the order they are entered.
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Roadway Features Tab
Enter all features, circumstances, and work zones that pertain to the accident.

Diagram Tab
This is where the drawing of the accident will go, you can print and hand draw it in, use Paint from the
computer to insert the drawings or contact Southern Software about a program called Wreck Draw.

Narrative Tab
This is a free text field where the narrative of the accident needs to be entered.

Property Damaged Tab
List any property and the owners information to any proerty that was damaged during the accident.

Witness Tab
List general information about any witnesses to the accident.

Traffic Violation Tab
List any citations that were issued as a reslut from the accident.

Image Tab
You may attach images that were taken in reference to the accident and view them here. Each line
item is a free text field and you will need to give a brief description of the photo.
When adding images through this tab, the RMS system will compress the photos to all be the same
size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.
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Citation

Make sure that these fields are completed to best of your knowledge; this module is used to produce
the yearly racial profiling reports for your agency.

General Tab
Citation Number: If your agency uses this system for ticket writing then you can have this system auto
number, if your agency uses this as a database for paper tickets then you can enter the paper tickets
citation number.
Complete the rest of the information just as North Carolina paper copy citations.

Department Info Tab
This is for the information regarding the issuing officer and other information from the citation;
Weather, Visibility, Traffic, Accident, etc.

Charges Tab
List charges and other information regarding the charge from the citation.
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Officer Notes Tab
Any other information or notes that could be used for court later could be entered here; this is a free
text field.

Image Tab
You may attach images that were taken in reference to the accident and view them here. Each line
item is a free text field and you will need to give a brief description of the photo.
When adding images through this tab, the RMS system will compress the photos to all be the same
size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.
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Evidence Stored Property

File: Import from Incident. This allows you to pull the data from the incident report and will auto fill a
portion of the property.

General Tab
This is where you will be entering the items, incident number and tag number and the reason it is going
into evidence. There is also a free text field of notes on this tab.
Tag Number: This can be set to auto assign or if your agency is using this just for a database and will
not be using the bar code system with it then you can manually type the number from the manual tag.
View Owner Button: This is where you will enter the owner of the items that were taken. This will pull
information from Master Name.
View Obtained From: This is the information regarding who you received the item from, if it is from the
owner you can check the box and the information will pull it from the Owner box completed. If it was
from someone else enter that information along with where it came from and by which officer turned
it in.
Complete the fields to the best of your ability.
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Items Tab

Each item per an incident can be entered into one Evidence Entry. You will work your way through the
tabs to show the item entered into evidence. The Storage Tab also has the buttons to see the history of
the item for the storage locations, where you can print an item sheet and print the barcode if your
agency is using the bar-coding system. On the bottom of this tab is Chain of Custody where it will show
each time the item has been moved, by who and where it is going. The Disposition tab for the item is
also located at the bottom of this Item Tab.

Suspect/Offender Tab
This is the information for which the evidence belonged to.

Offense Tab
This is to show the related offenses to the items.
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Image Tab
You may attach images that were taken in reference to the property and view them here. Each line
item is a free text field and you will need to give a brief description of the photo.
When adding images through this tab, the RMS system will compress the photos to all be the same
size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.
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Pawn Ticket

If your agency processes pawn tickets, this is a place to enter them, allowing the items to be cross
referenced.

General Tab
Enter the general information regarding the item, seller, pawn shop name and sold information.

Items Tab
This is where the individual items can be entered with the identifying information.
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Image Tab
You may attach images that were taken in reference to the property and view them here. Each line
item is a free text field and you will need to give a brief description of the photo.
When adding images through this tab, the RMS system will compress the photos to all be the same
size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.
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Warning Tickets

This module can be used for Warning tickets for your department and some agencies use this module
for Animal Control tickets. It can be customizable to your agency needs depending on how your local
policy wants to use it.
If your agency does use this module just make sure you complete each blank similar to previous
module.

General Tab
Enter the general information regarding the person and charge information.

Vehicle Info Tab
Enter the vehicle information regarding the offense.

Comments Tab
The comments tab is a free text field to type a brief narrative in.
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Image Tab
You may attach images that were taken in reference to the ticket and view them here. Each line item
is a free text field and you will need to give a brief description of the photo.
When adding images through this tab, the RMS system will compress the photos to all be the same
size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.
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Ordinance Tickets

If your agency processes Ordinance Tickets this module can be used for that, and to also track
payments and overdue payments on those tickets.

General Tab
Enter the general information regarding the ticket, location, person, and charge information. This
module also allows you to print a receipt from this page.

Vehicle Info Tab
Enter the vehicle information regarding the offense.

Comments Tab
The comments tab is a free text field to type a brief narrative in.
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Image Tab
You may attach images that were taken in reference to the ticket and view them here. Each line item
is a free text field and you will need to give a brief description of the photo.
When adding images through this tab, the RMS system will compress the photos to all be the same
size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.
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Criminal Papers

This module is a warrant database. It is customizable to your department needs. This will track the
warrants and their status, how they are served and who they are served by. This module has several
reports that are built into the system that can help with department statistics.

General Tab
Enter the general information regarding the criminal paper (warrant), offense, person, and service of
the paper. This module also allows you to add service notes and keep track of service attempts.

Arrest/Court/Misc Info
This tab is for the NIC number of the NCIC entry of the warrant, bond types, amounts, and court
information.

Complainant
This is for person information.
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Witness
This is for person information.

Care of/Left With
If you served a parent/guardian or left the papers with someone other than the issued to person that is
to be noted here.

Image Tab
You may attach images that were taken in reference to the paper and view them here. Each line item
is a free text field and you will need to give a brief description of the photo.
When adding images through this tab, the RMS system will compress the photos to all be the same
size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.
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Civil Papers

This module for Civil Papers can be used for a variety of different things such as inmate parole plans to
your jurisdiction, criminal trespass database, protective orders, etc. This module can have several
types of civil papers entered into it to use.

General Tab
Enter the general information regarding the civil paper, offense, person, and service of the paper. This
module also allows you to add service notes and keep track of service attempts.

Court/Misc Info
This tab is for the court information and service fees. To enter other fees associated with the civil
paper the levy button will open a fee entry sheet.

Defendant
This is for person information.
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Plaintiff
This is for person information.

Attorney
This is for person information.

Care of/Left With
If you served a parent/guardian or left the papers with someone other than the issued to person that is
to be noted here.

Image Tab
You may attach images that were taken in reference to the paper and view them here. Each line item
is a free text field and you will need to give a brief description of the photo.
When adding images through this tab, the RMS system will compress the photos to all be the same
size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.
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Sex Offender/Felon Registration

The Sex Offender module does not replace state reporting, it will allow for the information to be a part
of your local Master Name Index.

General Tab
Enter the general and personal information regarding the registration information.

Offense
Enter the offense that the registrant is charged with.

Other State Offenses
Enter the offenses that the registrant is charged with from another state.
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Image Tab
You may attach images that were taken in reference to the paper and view them here. Each line item
is a free text field and you will need to give a brief description of the photo.
When adding images through this tab, the RMS system will compress the photos to all be the same
size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.
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Gun/Property Registration

This module will also apply to local policy if you agency registers property or guns to your local citizens.

General Tab
Enter the general information regarding the registration and property information, and the personal
information of the registering person.

Notes
Free text field for notes.
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Image Tab
You may attach images that were taken in reference to the property and view them here. Each line
item is a free text field and you will need to give a brief description of the photo.
When adding images through this tab, the RMS system will compress the photos to all be the same
size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.
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Officer’s Activity Log

This module allows for officers to enter their daily activity if local policy agrees to do so, several fields
in this module are customizable to your local agency.

General Tab
The events drop down is customizable to the department. You can click on the buttons on the bottom
to add multiple events, or print the events and see the details.
The comments box is searchable; however it is a free text box.
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Image Tab
You may attach images that were taken in reference to the property and view them here. Each line
item is a free text field and you will need to give a brief description of the photo.
When adding images through this tab, the RMS system will compress the photos to all be the same
size.
1. Add Multiple Images: This will take you to where you have the images stored and allow you
to select which images you would like attached to the report.
2. Print All Images: This allows you to print all of the images at once, which will print 6 per a
horizontal page, with labels underneath them.
3. Print Image: This will print the single image that is selected.
4. View Image: This allows you to view the selected image. When in view mode you can copy
the image to a clipboard and paste into a document or email.
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User Inbox

The Inbox and Case management within the RMS is used to notify user, supervisors and others of new
reports, updated or modified reports, reports assigned for investigation, reports assigned for
correction and other.
Routing: The act of sending a record through the chain of approval process. Routing sends an incident
to the supervisors of a Division, Unit or specific officers. They can also have notes attached to them
that are not included in the incident.
Assignment: Incidents are assigned to individuals for correction or investigation. They can also have
notes attached to them that are not included in the incident.
Supervisor: Anyone that can approve or assign an incident to anyone else. This does not mean that the
supervisor is anyone superior in the agency.
Acknowledge: This will clear it from you main page.
Acknowledge All: This will clear all items on the main page at once.
View: Will take you to the incident in view mode only.
Edit: Will take you to the incident in edit mode only.
Print: This will print the screen you are on; to print all of the tabs click the print all button on the
bottom of the box.
View Notes: This allows you to view the notes associated to the incident.
Clear: If you have this permission then this will allow you to clear the incident from all of the tabs.
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Department Call Log

If your agency uses Department Call Log, this is a place to enter them, allowing the items to be cross
referenced.
This module is primarily used in small agencies that do not have a full time dispatch center.
You will complete this by going field by field:
You can only add one victim, accused, and vehicle per event.
At the bottom there is a preview screen of all active calls until they are closed out.
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Processing

This feature works similar to Master Name Index; however you can update information through here
without having an incident.
This feature can be used for a pre-booking feature for jail, or field contacts/interview feature.
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Master Search

This feature allows you to search the different modules throughout the RMS program.
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Create Lineup

The Create Lineup module can assist in creating a lineup out of your mug shot database. You will set
the criteria that meet your requirements for the line up. Once you have selected the needed
characteristics, you can browse through all photos and choose the ones you want in your line up. Then
go to the Browse Search Results Tab and you can view the images that your search created. From
there you can choose to use image one or two and click Add Image To Line Up. Once you have
selected the six images for your line up, you can go to the View Lineup Tab. This tab is where you will
print, move images in the lineup.
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Summary Reports
The Summary Reports modules have over 100 pre-built reports in the system. Under the All tab you
can see all reports or even break it down to which module you need to pull a report from. Once you
select a report that you would like to pull, a brief description will show on the main page, you can then
select to Preview or Print directly.
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Once you select how you would like to generate the report you will be prompted to enter the correct
data (dates, units, etc.) to create the report.

After the report has been created, you can export the report to Snapshot, Excel, Word, or Notepad
Text. To do this go to File>Save Report To File, and choose which program you want to create the file
in. When exporting data to Excel you are able to clean the columns and data up and then create
charts.
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Master Name Search
You can search by full, partial and initials once you have searched your information all of the
information pertaining to the searched person.

Master Name is the database containing all information attached to person such as: General
Information, Alias, Physical Features, Involvement History, Prior Info, Caution Indicators, ID Numbers,
MO’s, Known Bias, Medical Conditions, Notes (free text field for any other information), and Images. If
the name has a Photo attached to it the top right button will be blue to let you know that an image is
attached.
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